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Preface 
The Oracle documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology 
Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the 
latest versions of the Oracle Agile EDM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle Documentation folder 
available on your network from which you can access the documentation (PDF) files. 

Note  To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or 
later. This program can be downloaded from the Adobe Web site 
(http://www.adobe.com). 

 

Note  Before calling Agile Support about a problem with an Oracle Agile EDM manual, please 
have the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Oracle Agile EDM can be found in the Release Notes file on the 
Oracle Technology Network (OTN) Web site 
(http://www.oracle.com/technology/documentation/agile_eseries.html) 

Oracle Training Aids 

Go to the Oracle University Web page 
(http://www.oracle.com/education/chooser/selectcountry_new.html) for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  
This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.

 v 
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Chapter 1  

Introduction 
 

This guide describes how to install Oracle 11g and adapt the Oracle database for the use with Agile 
e6.1.1, running under Windows 2000/XP/2003. 

Where to Go for More Information 
For additional information, consult the Oracle online installation and administration documentation. 

http://download.oracle.com/docs/cd/B28359_01/install.111/b32006/toc.htm 
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Chapter 2  

Requirements 

Hardware and Software Requirements 
Requirement   Min imum Value 

Physical memory (RAM) Minimum 1GB 

Refer to the Hardware Sizing documentation to 
determine the required memory for your specific Oracle 
Server installation.  

Virtual memory Double the amount of RAM 

Disk space for software files 8 GB (8388608 KB). It could be smaller depending on 
the components chosen to be installed. 

Disk space for database files Refer to the Hardware Sizing documentation to 
determine the required space for the database creation. 

System architecture Processor: Intel (x86), AMD64, and Intel EM64T 

Operating system Microsoft Windows Server 2003 32 or 64 bit. 

Microsoft Windows Server 2008 64 bit. 

Note Microsoft Windows Server 2003 only 
If this machine will be used for Oracle Database 
installation/database creation and applications 
will run on the same machine, the following 
processor is  only supported: Intel (x86). 
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Chapter 3  

Prepare the System 
 

1. You have to be logged on as a member of the Administrators group to the computer on which 
to install Oracle components.  

2. Create the directories/drives for distribution of the data files depending on the number of disks 
prepared for Oracle installation. For instance, if you have prepared 3 disks -  

 E:\ 

 F:\ 

 H:\ 

The drive letters E:, F:, H: are just examples. It is up to you. Subdirectories will be created later in 
these directories by database creation (see Chapter 4). 

Download Oracle Installation Media 
Microsoft Windows Server 2008 

 

1. Download and uncompress the Oracle Database 11g Release 1 (11.1.0.7.0) for Microsoft 
Windows Server 2008 (part 1 and 2), 64-bit from Oracle eDelivery web site. 

Packages could be found under product pack ‘Oracle® Database 11g Release 1 (11.1.0.6.0) 
Media Pack for Microsoft Windows x64 (64-bit)’ 

 

Microsoft Windows Server 2003 

 

1. Download and uncompress the Oracle Database 11g Release 1 (11.1.0.6.0) for Microsoft 
Windows (part1 and 2)  32- or 64-bit from Oracle eDelivery web site. 

2. Download and uncompress the Oracle® Database 11g Release 1 (11.1.0.7.0) Patch Set for 
Agile Engineering Data Management (Release e6.1.1) for Microsoft Windows for relevant 
platform (32- or 64-bit) 
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Chapter 4  

Installing Oracle 11g 
This chapter provides instructions for installing the Oracle 11g Database for use with Agile e6.1.  

Installation steps for Oracle for Microsoft Windows 2003 and Microsoft Windows 2008 are similar,  
just the database version is 11.1.0.6 for Microsoft Windows 2003 and 11.1.0.7 for Microsoft 
Windows 2008. 

Start the Oracle Database 11g Installation 
1. Start setup.exe from the downloaded Oracle Installation Media. 

2. Select Advanced Installation.  

3. Click Next to continue.  

4. Choose the Custom installation and click Next. 

 

The window for defining the ORACLE_HOME name and path is opened. 

5. Enter the full path of your Oracle home directory and click Next. 
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If the Oracle Home is not a subdirectory of the Oracle Base directory, you will get the warning 
message like 

 

It is not critical if you ignore this warning. But if possible, specify Oracle Home as a 
subdirectory of Oracle Base. 

6. Only for installation on Windows 2008 (by installation on Windows 2003 this step is performed 
by patch 11.1.0.7 installation). 

Provide email and Metalink password if you like to be informed of security issues and to 
receive security update via Metalink (optional fields, could be left blank). This option can be 
configured later if needed. Click Next to continue. 
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7. Only for installation on Windows 2008 (by installation on Windows 2003 this step is performed 
by patch 11.1.0.7 installation). 

       If the email and password are not provided, you will get the warning message. You can ignore 
it by clicking Yes. 

 

8. Oracle Universal Installer (OUI) performs prerequisite checks. 
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The Installer verifies that your environment meets all of the minimum requirements for 11g 
installing and configuring. The overall result of the check must be ‘Passed’. If some checks 
have failed, cancel the installation and verify once again if your system meets the hardware 
and software requirements. Then start the installation again. 

9. Click Next to proceed. 

The next window lets you select the components to be installed.  

10. Select the components you want to install and click Next. 

 

11. In the Create Database window, select Install database Software only as you will create the 
database later. Click Next. 

 

12. Review the options you have chosen in the Summary window.  

To make changes click Back. 
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13. If the options are correct, click Install to start the installation. 

Oracle 11g will be installed. This may take some time.  

 

14. To leave the Oracle Installer click Exit. 

Installing Patch 11.1.0.7 
If you are installing Oracle Database 11g on Windows Server 2008, you have to skip 11.1.0.7 patch 
installation – installed version is 11.1.0.7 and no need patch to be installed. 

1. Download and uncompress the Oracle® Database 11g Release 1 (11.1.0.7.0) Patch Set for 
Agile Engineering Data Management (Release e6.1.1) for Microsoft Windows for relevant 
platform (32- or 64-bit) from Oracle eDelivery web site. The downloaded zip package contains 
the directory Agile_e611_db_patches_MSWIN (for 32-bit) or 
Agile_e611_db_patches_MSWIN64 (for 64-bit) 

Oracle® Agile Engineering Data Management Chapter 4- 11

 



Installation Manual for Oracle 11g on Windows for Agile e6.1.1  
 

2. Start Oracle Universal Installer (setup.exe) 
Agile_e611_db_patches_MSWIN\database\11_1_0_7\setup.exe (for 32-bit) 

Agile_e611_db_patches_MSWIN64\database\11_1_0_7\setup.exe (for 64-bit) 

3. Click Next when the Welcome screen appears. 

 

4. Select Oracle Home (where database was installed in the previous steps) name and path and 
click Next. 

5. Select Oracle Home (where database was installed in the previous steps) name and path and 
click Next. 

 

6. Provide email and Metalink password if you like to be informed of security issues and to 
receive security update via Metalink (optional fields, could be left blank). This option can be 
configured later if needed. Click Next to continue. 
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7. If the email and password are not provided, you will get the warning message. You can ignore 
it by clicking Yes. 

 

8. If the prerequisite checks passed, click Next. If any of checks has failed, see the details in the 
box below. Abort the installation by click on Cancel, ensure that all prerequisites are met and 
start the patch installation again. 
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9. The summary window appears. Click Next to begin the installation. 

 

10. Click on Exit when installation is finished. 

 

Database Creation 
The database will be created by using the Database Configuration Assistant (DBCA) templates. 
DBCA templates include database options, initialization parameters, and storage information for 
data files, table spaces, control files and redo logs. 

Five different templates are predefined to meet different requirements according to purpose, size 
and number of the Agile e6.1.1 database installations. If you install a RAC database, you only must  
use the RAC database templates (see the table below). 
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Template  Name Descr ipt ion 

plm_demo database designed for test installations 

no archiving 

plm_prod_small database designed for productive use 

max number of concurrent users: 40 

archiving enabled 

plm_prod_medium database designed for productive use 

max number of concurrent users: 80 

archiving enabled 

plm_prod_large database designed for productive use 

max number of concurrent users: 120 

archiving enabled 

plm_prod_Xlarge database designed for productive use 

max number of concurrent users: 150 

archiving enabled 

RAC_plm_demo RAC database only 

database designed for test installations 

no archiving 

RAC_plm_prod_small RAC database only 

database designed for productive use 

max number of concurrent users: 40 

archiving enabled 

RAC_plm_prod_medium RAC database only 

database designed for productive use 

max number of concurrent users: 80 

archiving enabled 

RAC_plm_prod_large RAC database only 

database designed for productive use 

max number of concurrent users: 120 

archiving enabled 

RAC_plm_prod_Xlarge RAC database only 

database designed for productive use 

max number of concurrent users: 150 

archiving enabled 

Additional information on significant database parameters and settings of each template can be 
found in the Appendix A. Decide which template corresponds approximately to your needs. It is also 
possible to adapt any of the values during the database creation process.  
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1. Refer to the downloaded media pack - Oracle Agile Engineering Data Management Application 
Release e6.1. All templates are in addon/db/windows/templates directory. 

2. Copy the DBCA template file (e.g. plm_prod_medium.dbt) to 
%ORACLE_HOME%\assistants\dbca\templates directory. 

3. Start the Oracle Database Configuration Assistant from the Windows start menu. 

Start > Programs >Oracle – ORA111 > Configuration and Migration Tool > Database 
Configuration Assistant.  

An introduction window is opened.  

4. Click Next to start the database configuration. 

5. Select Create a database and click Next.  

 

A list of different templates is provided. You should also see the template that you have chosen 
and copied in step 1. 
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6. Select the template you want to use and click Next. 

7. Enter the global database name and SID (default: plm61) and click Next. 

The next window provides the possibility to centrally manage Oracle databases using Oracle 
Enterprise Manager Database Control.  

8. Select this option and click Next. 

 

9. A message is displayed that a listener has to be configured first - prior to configuring database 
by dbca.  

If a configured listener for this Oracle Home already exists, this step will be skipped (no 
warning message appears) and by click on Next, you will see the screen from step 18. In this 
case skip the steps 9-17 and go to step 18. 

 

10. Click OK to close the warning message.  

11. Start the Oracle Net Configuration Assistant from the Windows start menu. 

Start > Programs >Oracle – ORA111 > Configuration and Migration Tool > Net Configuration 
Assistant. 

An introduction window is opened.  
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12. Select Listener configuration and click Next. 

 

13. Select Add from the list and click Next. 
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14. Choose name for the listener – LISTENER and click Next. 

 

15. Select TCP from Available Protocols (selected by default) and click Next. 
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16. Select the standard port – 1521 – for listener and click Next. 

 

17. Select No to not configure another listener and click Next. 
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18. Click on Next and then Finish. The Listener configuration is completed. 

19. Go back to the dbca and click Next. 

 

20. Enter passwords for SYS, SYSTEM, SYSMAN and DBSNMP. It is highly recommended to use 
different passwords for these accounts. Click Next. 
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The next window allows registering your database with a directory service.  

21. Select No, do not register the database and click Next. 

 

22. Select File System for database storage and click Next. 

23. In the next window, choose Use Database File Locations from Template and click Next. 
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24. Deselect the option Specify Flash Recovery Area in the next window.  

Depending on your backup strategy and used template, archiving could be enabled. Click Next.  

Note  For productive database it is highly recommended to archive the database. The 
destination of the archive directory can be specified by clicking on the Edit Archive 
Mode Parameters button. 

 

If you have enabled archiving and not specified at least one Archive Log Destination, the 
following error message appears: 
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25. The next window provides database features as well as the possibility to run custom scripts 
after database creation. It is not recommended to change the settings provided by the 
template. Click Next. 

26. The next window provides diverse database parameters. You can navigate to the setting of 
memory, character sets, database sizing, and connection mode. Usually all parameters are set 
by selected template and you don’t need to change them, but experienced users could modify 
some parameters depending on the current case. Check if the connection mode is set to 
Dedicated Server Mode in the folder Connection Mode. 

27. Click Next. 

 

28. In the next window choose the option ‘Revert to pre-11g default security settings’ and ensure 
that both checkboxes under this option are activated. Click Next.  

 

Note  Database passwords case-sensitivity is disabled (set by the parameter 
sec_case_sensitive_logon). Do not enable it after database creation. 
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29. Uncheck the box Enable automatic maintenance tasks and click Next. 

 

30. In the next window click File Location Variables.  

Enter values for the variables in the table. As value you should provide the directories created 
in Chapter 3 – in this example E:\, F:\, H:\. DBCA will create the subdirectory oradata\plm61 in 
these directories where the database data files will be created in. See the table for detailed 
information on predefined file destination variables. 

Var iable  Descr ipt ion 

ORADATA1 Directory for data files for table spaces EDB, EDB_LOB, 
EDB_TMPIDX 

ORADATA2 Directory for data files for table spaces EDB_IDX,  EDB_TMP 

ORADATA3 Directory for data files for temporary table space TEMP 

ORADATA4 Directory for data files for UNDO table space 
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ORADATA5 Directory for data files for table spaces SYSTEM, TOOLS, 
USERS, SYSAUX 

ORAARCH Directory for Archive log files 

REDO1 Directory for Redo log files 

REDO2 Directory for Redo log files 

If you have less than 8 disks (five for data files, two for redologs and one for archived 
redologs), follow the instructions below to place the data files/redologs/archived redologs. 

 Number of disks: 1 

Disk1: ORADATA1, ORADATA2, ORADATA3, ORADATA4, ORADATA5, REDO1, REDO2, 
ORAARCH 

 Number of disks: 2 

Disk1: ORADATA1, ORADATA4, ORADATA5, REDO1 

Disk2: ORADATA2, ORADATA3, ORAARCH, REDO2 

 Number of disks: 3 

Disk1: ORADATA1, ORADATA5 

Disk2: ORADATA2, ORADATA4, REDO1 

Disk3: ORADATA3, ORAARCH, REDO2 

 Number of disks: 4 

Disk1: ORADATA1, REDO1 

Disk2: ORADATA2, REDO2 

Disk3: ORADATA3, ORAARCH 

Disk4: ORADATA4, ORADATA5 

 Number of disks: 5 

Disk1: ORADATA1, REDO1 

Disk2: ORADATA2, ORAARCH 

Disk3: ORADATA3, ORADATA5 

Disk4: ORADATA4 

Disk5: REDO2 

 Number of disks: 6 

Disk1: ORADATA1 

Disk2: ORADATA2, ORAARCH 

Disk3: ORADATA3 

Disk4: ORADATA4 

Disk5: ORADATA5, REDO1 

Disk6: REDO2 

 Number of disks: 7 

Disk1: ORADATA1 
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Disk2: ORADATA2 

Disk3: ORADATA3 

Disk4: ORADATA4 

Disk5: ORADATA5, ORAARCH 

Disk6: REDO1 

Disk7: REDO2 

 Number of disks: 8 

Disk1: ORADATA1 

Disk2: ORADATA2 

Disk3: ORADATA3 

Disk4: ORADATA4 

Disk5: ORADATA5 

Disk6: ORAARCH 

Disk7: REDO1 

Disk8: REDO2 

  

31. Click OK when you have finished. 

The storage parameters for control files, table spaces, data files, rollback segments, and redo 
log files can be reviewed and modified. Double-click an object in the left window section if you 
want to edit and modify the settings in the right window section. The required new table spaces 
can be created. 
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Note  The predefined values are recommended by Agile according to the chosen kind of 
database installation. 

32. When you have finished click Next. 

33. Select Create Database to start the database creation immediately.  

 

It is recommended to choose also the option Generate Database Creation Scripts and to define 
a destination directory (default: %ORACLE_BASE%\admin\plm61\scripts). Those scripts are 
useful for future reference or use. 

34. Click Finish. 

Chapter 4 - 28 Oracle® Agile Engineering Data Management 

 



Installation Manual for Oracle 11g on Windows for Agile e6.1.1  
 

A summary of the database parameter is displayed.  

35. Click Save as HTML file for future reference and click OK. 

The database creation process is started.  

36. Click Exit to finish the process. 

Configuring tnsnames.ora and sqlnet.ora  
1. Start Oracle Net Services Configuration Tool. 

Start menu->Programs->Oracle-ORA111->Configuration and Migration Tools->Net 
Configuration Assistant 

2. Select Local Net Service configuration. Click Next. 

 

3. Select Add and click Next. 
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4. Enter the Service Name – plm61.domain.com, where <domain.com> is your domain name and 
click Next. 

 

5. Select TCP protocol and click Next. 
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6. Enter the fully qualified machine name – where Oracle database is - and click Next. 

 

7. Select not to perform test and click on Next. 
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8. Finally, select the Net Service Name – plm61 and click Next. 

 

9. Select not to configure another service and click Next. 
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10. Net service name configuration complete. Click on Next and then on Finish to quit. 

 

11. Start the Oracle Net Manager 

Start menu->Programs->Oracle-ORA111->Configuration and Migration Tools->Net Manager 

12. Expand view for Local and click on Profile.  
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13. Enter your domain name in the field Default Domain. 

14. Save the configuration by File->Save Network Configuration from the main menu and exit the 
Net Manager by click on File->Exit. 

15. Test the database connection.  
sqlplus system@plm61/<SYSTEM password> 
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Chapter 5  

Modify the Oracle Database 

Create a Database User and Role 
You will need to create the Agile e6.1 database user and role and provide the necessary privileges 
and quotas. You can do this using the following commands or using the Oracle Enterprise Manager 
Database Control as described in the section below. 

Using SQL to Create a Role 
1. Check if the plm role exists – open sqlplus session, connect as SYSTEM and execute 

select role from dba_roles where role=’AGILE_E_ROLE’; 

2. If string ‘AGILE_E_ROLE’ is returned, the role exists. Then skip the role creation and continue 
with the user creation. Otherwise, the role has to be created. 

3. Use the sql code below to create the role AGILE_E_ROLE: 

create role AGILE_E_ROLE; 
GRANT CONNECT TO AGILE_E_ROLE; 

GRANT CREATE TABLE TO AGILE_E_ROLE; 

GRANT CREATE VIEW TO AGILE_E_ROLE; 

GRANT CREATE SYNONYM TO AGILE_E_ROLE; 

GRANT CREATE DATABASE LINK TO AGILE_E_ROLE; 

GRANT CREATE SEQUENCE TO AGILE_E_ROLE; 

GRANT ALTER SESSION TO AGILE_E_ROLE; 

GRANT CREATE PROCEDURE TO AGILE_E_ROLE; 

GRANT CREATE TRIGGER TO AGILE_E_ROLE; 

GRANT ALL ON DIRECTORY ORA_DMP TO AGILE_E_ROLE; 

Using SQL to Create a User 
1. Use the sql code below to create the plm schema  (named, e.g. PLM): 

CREATE USER PLM 

IDENTIFIED BY <PASSWORD>  

DEFAULT TABLESPACE "EDB"  

TEMPORARY TABLESPACE "TEMP"  

PROFILE DEFAULT  

QUOTA UNLIMITED ON "EDB"  

QUOTA UNLIMITED ON "EDB_IDX"  

QUOTA UNLIMITED ON "EDB_TMP"  

QUOTA UNLIMITED ON "EDB_TMPIDX"  

QUOTA UNLIMITED ON "EDB_LOB"  

ACCOUNT UNLOCK; 

GRANT "AGILE_E_ROLE" TO PLM; 
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ALTER USER PLM DEFAULT ROLE AGILE_E_ROLE; 

 

You can create AGILE_E_ROLE role and plm schema also by executing the script 
cre_plm_usr.sql in directory addon/db/sql. 
SQL>@<full path to the file cre_plm_usr.sql> 

Username (e.g. PLM) and password have to be provided. 

Using Enterprise Manager Database Control to Create a User 
1. Start the Enterprise Manager Database Control.  

By default it can be invoked on https://localhost.localdomain:5501/em/console, but it can be 
configured manually to use another port.  

2. Click on Login. 

 

3. Click on Server tab and in the security section on Users. 

4. Click Create. 

 

 

5. Click on the General tab and insert a user name and password and assign default and 
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temporary table space. 

6. In the Roles tab click Edit List.  

7. Select role AGILE_E_ROLE from the list with available roles and click Move. 

The role is moved to the Selected Roles.  

8. Click OK.  

 

Role AGILE_E_ROLE should have been created in the previous step. 

9. Open the Quotas tab and assign unlimited quota to EDB, EDB_IDX, EDB_LOB, EDB_TMP 
and EDB_TMPIDX. 

 

10. Click OK to finish the database user creation. 

Import the Database Dump 
Import the Agile e6.1 dump using the following commands, and then check the log file for errors. 
Make sure that a correct value is set for the environment variable NLS_LANG (value from the file 
csh_ORA11.1 - AMERICAN_AMERICA.WE8MSWIN1252). 
imp plm/plm@plm61 file=plm61.dmp log=plm61.log buffer=500000 commit=y 
statistics=none full=y 
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commit=y Rollback segments cannot get too small 

statistics=n No statistics will be created 

buffer=500000 Necessary for lobs, better performance 

full=y  Iimports full dump even if the dump was exported by different user 

Create Directories for Oracle Data Pump Utility 
1. Create directory object which will be used for Oracle Data Pump Export/Import Utility with two 

subdirectories - system and user (for instance d:\ora_dmp\system; d:\ora_dmp\user). 

2. Open a sqlplus session and connect as ‘system’. 
sqlplus system/<system password> 

3. Run the script ddl_pump_dir.sql which is located in addon/db/sql directory 
SQL>@<full path to the file ddl_pump_dir.sql> 

4. Enter the path to the main directory created under step 1 (for instance d:\ora_dmp). 

The script will create two directory objects – one for system users and one for normal users 
and will give rights on the second directory to user PLM. 

Compile All Invalid Objects in Schema PLM 
After importing the Agile e6.1 dump some objects might be invalid. This could be verified by the 
following way: 

1. Open a sqlplus session and connect as ‘system’. 
sqlplus system/<system password> 

SQL>select * from dba_objects where status <> ’VALID’ and owner=’PLM’; 

If the returned message is ‘no rows selected’, then you have no invalid objects.  

2. Otherwise, you have to run the script compile_all.sql which is located in addon/db/sql directory. 
SQL>@<full path to the file compile_all.sql> <parameter>  

 

Note  Parameter = SQL user; e.g. PLM. The parameter has to be entered in upper case 
only. 

3. Verify once again that there are no invalid objects: 
SQL>select * from dba_objects where status <> ’VALID’ and owner=’PLM’; 

Gather Statistics 
In Oracle 11g the default value for the OPTIMIZER_MODE initialization parameter is ALL_ROWS, 
which means that a cost-based approach will be used for all SQL statements. Agile highly 
recommends creating statistics in order to avoid performance loss. This should be done after the 
dump import and has to be repeated periodically. 

1. Calculate statistics of all tables and indexes in db schema PLM: 
SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS('PLM',CASCADE =>true); 
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2. Calculate statistics of all tables and indexes in db schema PLM with 5% of the rows: 
SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS('PLM', estimate_percent => 
5, CASCADE =>true); 

3. Drop all statistics of PLM schema objects. Optimizer is now running in rule mode. 
SQL> EXECUTE DBMS_STATS.DELETE_SCHEMA_STATS('PLM'); 

For all schema objects, statistics have to be available to support the cost based optimizer. If 
tables and indexes are modified or created, statistics must be established. 

4. Calculate statistics on all tables without statistics and their indexes in db schema PLM with 5% 
of the rows: 
SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS(ownname => 'PLM',options 
=> 'GATHER EMPTY', estimate_percent => 5, CASCADE =>true);  

5. Calculate statistics on tables t_master_dat and their indexes in db schema PLM_ENTW with 
10% of the rows: 
SQL> exec sys.dbms_stats.gather_table_stats(ownname=> 'PLM_ENTW', 
tabname=> 'T_MASTER_DAT', partname=> NULL , estimate_percent=> 10 
,cascade=> true); 

 

Note  Statistic information can be viewed, e.g. in user_tables and user_indexes. These 
views provide information about e.g. average width of the row and number of rows. 

Uninstall Oracle for Windows  
If you have an improper Oracle installation, a second installation will fail. You have to uninstall 
Oracle and then try from beginning. The automatic Oracle installation performed by Agile e6.1 or 
axalant setup is only possible if Oracle is not installed on the system. 

1. If you want to uninstall Windows Service entries for databases, use oradim (oradim -delete 
-SID plm61) 

2. Shutdown all Oracle Services. 

3. Start Oracle Installer. 

4. Select all packs except the Oracle Installer itself. 

5. Press Remove. 

6. Drop Oracle folders  

(Oracle Home: d:\oracle\product\11.1\database, Oracle Installer: C:\Program Files\Oracle) 

7. Drop the registry leave HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE. 

8. If Windows services still exists, drop the special registry sections in 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Oracle*. 

9. Reboot the computer. 
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Oracle Installation/Database creation on Windows 
Failed 
If the software is installed (d:\oracle\product\11.1\database\*) and registry entries are created 
(HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE), the creation of the database may fail due to 
the following reasons:  

 Insufficient memory (Oracle parameters to high, small RAM size)  

 Incorrect internal password  

 No administrative rights on the machine  

 Wrong path definition  

 Not enough disk space for data files  

 

When having troubles with the database creation, check the following:  

 Database creation logs: %ORACLE_BASE%\cfgtools\dbca\plm61 

 Instance Parameter file: %ORACLE_BASE%\admin\plm61\pfile\init.ora 

 Instance SPFILE: %ORACLE_HOME%\database\spfileplm61.ora 

 Diagnostics: %ORACLE_BASE%\diag\rdbms\plm61\plm61 

 Network configuration: %ORACLE_HOME%\network\admin\*.ora 
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Chapter 6   

Appendix 
The most significant parameters of the predefined Database Configuration Assistant templates are 
referenced in the following. 

Template “plm_demo” 
Parameter /Set t ing  Value  

db_block_size 8 k 

memory_target 400 MB 

db_file_multiblock_read_count 8 

open_cursors 600 

processes 80 

Table spaces locally managed 

EDB 500 MB 

EDB_IDX 500 MB 

EDB_LOB 150 MB 

EDB_TMP 150 MB 

EDB_TMP_IDX 150 MB 

Redolog file size 5 MB 

archiveLogMode FALSE 

Template “plm_prod_small” 40 Users Max 
Parameter /Set t ing  Value  

db_block_size 8 k 

memory_target 600 MB 

db_file_multiblock_read_count 8 

open_cursors 600 

processes 100 

Table spaces locally managed 

EDB 2000 MB 

EDB_IDX 2000 MB 

EDB_LOB 500 MB 

EDB_TMP 500 MB 

Oracle® Agile Engineering Data Management Chapter 6- 41

 



Installation Manual for Oracle 11g on Windows for Agile e6.1.1  
 

EDB_TMP_IDX 500 MB 

Redolog file size 10 MB 

archiveLogMode TRUE 

Template “plm_prod_medium” 80 Users Max 
Parameter /Set t ing  Value  

db_block_size 8 k 

memory_target 1050 MB 

db_file_multiblock_read_count 8 

open_cursors 600 

processes 180 

Table spaces locally managed 

EDB 5000 MB 

EDB_IDX 5000 MB 

EDB_LOB 1000 MB 

EDB_TMP 1000 MB 

EDB_TMP_IDX 1000 MB 

Redolog file size 10 MB 

archiveLogMode TRUE 

Template “plm_prod_large” 120 User Max 
Parameter /Set t ing  Value  

db_block_size 8 k 

memory_target 1600 MB 

db_file_multiblock_read_count 8 

open_cursors 600 

processes 260 

Table spaces locally managed 

EDB 10000 MB 

EDB_IDX 10000 MB 

EDB_LOB 2000 MB 

EDB_TMP 2000 MB 

EDB_TMP_IDX 2000 MB 

Redolog file size 10 MB 

archiveLogMode TRUE 
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Template “plm_prod_Xlarge” 150 Users and More 
Parameter /Set t ing  Value  

db_block_size 8 k 

memory_target 2000 MB 

db_file_multiblock_read_count 8 

open_cursors 600 

processes 320 

Table spaces locally managed 

EDB 20000 MB 

EDB_IDX 20000 MB 

EDB_LOB 5000 MB 

EDB_TMP 5000 MB 

EDB_TMP_IDX 5000 MB 

Redolog file size 10 MB 

archiveLogMode TRUE 
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